Resource I

Microsoft Access 2003
Pre-Test / Post-Test

	Chapter 5

	Pre Test / Post Test Questions


Fill in the blanks:

1. Microsoft Access is a desktop database management system that allows you to create and maintain _____ _____.

2. A key design principal of the type of databases from question 1 is _____, which emphasizes that each data item be stored in a single location.

3. Creating a relational database in Access requires that you place common _____ in each table you want to relate.

4. In a one-to-many relationship, the primary key of table A is unique (the one side) while the _____ _____ of table B allows duplicate values (the many side).

5. A _____ is a characteristic or attribute that may define, describe, empower, or constrain an object.

6. _____ _____ are the guidelines for how a person uses data in the real world.

7. Prior to editing a table or query, you can display the object’s _______ to see which other database objects may be affected by the modification.

8. A _____ _____ rule is an expression that defines the range of legal entries for a particular field.

9. A lookup field is a list of acceptable _____ that may be entered into a field.

10. You can import data stored in _____, which is a special markup language for defining and exchanging data on the Word Wide Web.

Multiple choice:

11. You can normalize data by dividing fields into logical groupings of what?

a. related reports

b. related forms

c. related tables

d. none of the above

12. Which type of a table relationship has a single record in table A relating to a single record in table B (and vice versa)?

a. one-to-many

b. one-to-one

c. many-to-many

d. none of the above

13. Which type of a table relationship has a single record in table A relating to one or more records in table B?

a. one-to-one

b. one-to-many

c. many-to-many

d. none of the above

14. Which type of a table relationship has a single record in table A relating to one or more records in table B, and a single record in table B relating to one or more records in table A?

a. one-to-one

b. one-to-many

c. many-to-many

d. none of the above

15. Which field property in Access defines a value or expression that is automatically entered for each new record?

a. Caption

b. Input Mask

c. Validation Rule

d. Default Value

16. Which field property in Access defines a default field label to appear on forms and reports, instead of using the field name?

a. Caption

b. Input Mask

c. Validation Rule

d. Default Value

17. Which property allows you to specify how the data should display and print?

a. Defined Value

b. Predefined Format
c. Format
d. Input Mask
18. Use which button to globally update the properties of other controls that are bound to a particular field?

a. Global Update

b. Property Update Options

c. Property Wizard

d. Format Property

19. To achieve consistency, which of the following would you use to control the way data is entered into a field?

a. input mask

b. text area

c. control box

d. data entry wizard

20. Which of the following represents an optional digit in an input mask?

a. “0”

b. “L”

c. “9”

d.  “>”

True / False:

21.  A flat-file database is a database whose design does not normalize its data.

22.  After normalizing, you establish relationships between tables in your dataset in order to recombine the data for analytical and reporting purposes.

23.  Referential integrity refers to a set of rules for maintaining the integrity of data stored in a relational database.

24. You can preview the relationships report before you print it.

25.  A field size of an integer consumes 2 bytes of storage.

26. A double field can hold a range of numbers whose values can have up to 7 decimal places.

27.  The format of table fields can be edited in the Field Grid pane when the table is shown in Design View.

28. Validation rules refer to the message that displays in a warning dialog box when a data entry violates a field- or record-level validation criterion.

29.  A record-validation rule evaluates when the insertion point first enters the record.

30.  You cannot import an object from one Access database into another Access database.

	Chapter 5

	Pre Test / Post Test Answer Key


Fill in the blanks

1. relational databases (5.1:AC 5-3)

2. normalization (5.1:AC 5-3)

3. fields (5.1.1:AC 5-6)

4. foreign key (5.1.1:AC 5-6)

5. property (5.1.4:AC 5-20)

6. Business rules (5.2:AC 5-22)

7. dependencies (5.2.1: AC 5-24)

8. field validation (5.3.3:AC 5-47)

9. values (5.3.5:AC 5-54)

10. XML (5.4.2:AC 5-63)

Multiple choice:


11. C (5.1:AC 5-3)

12. B (5.1:AC 5-5)

13. B (5.1:AC 5-5)

14. C (5.1:AC 5-5)

15. D (5.2:AC 5-23)

16. A (5.2:AC 5-23)

17. C (5.2.3:AC 5-31)

18. B (5.2.4:AC 5-34)

19. A (5.3.4:AC 5-50)

20. C (5.3.4:AC 5-53)

True / False:

21. T (5.1:AC 5-3)

22. T (5.1:AC 5-4)

23. F (5.1.2:AC 5-13)

24. T (5.1.3:AC 5-18)

25. T (5.2.2:AC 5-31)

26. F (5.2.2:AC 5-31)

27. T (5.3.1:AC 5-43)

28. F (5.3.3:AC 5-47)

29. F (5.3.3:AC 5-47)

30. F (5.4.1:AC 5-61)

Resource II

Microsoft Access 2003
Teaching Materials

	Chapter 5
	Working with Tables


Overview

Chapter 5 covers in more depth working with tables in Access.  The chapter provides instruction on working with relationships between tables, setting and modifying database and object properties, setting and modifying field properties, inserting a hyperlink field and storing hyperlink data in a table, and modifying a field’s type.

The chapter also goes on to cover the enforcement of referential integrity in a database, using input masks, default field values, validation rules, lookup fields, and the importing and exporting of objects and data to and from Microsoft Access. 

Tips and Teaching Strategies

Use caution when covering the creation of a lookup field.  Defining a lookup field might be easier to comprehend by first creating a new list and providing the list items.  You can then move on to demonstrate querying a table for a list of values to populate the list.

Another topic worth mentioning here is that of table relationships.  To novice users, relationships between tables (and the concept of related fields and keys) may be a bit overwhelming, as the topic of joining related data may not be a natural concept to introductory students.  The classic database example of a school’s registration system (tables of students, classes, instructors, departments, etc.) can help with this concept, as it is something every college-level student has exposure to. 

Section 5.1 – Building a Relational Database

Section 5.1 focuses on the use of relationships between tables.  The section provides instruction on defining table relationships, working with related tables including enforcing referential integrity, printing the relationships window, and setting object and database properties.

Section 5.1.1 – Defining Table Relationships

Concept:
Defining relationships between tables in Access

Method:
To create relationships between tables in Access, close all open tables, click on the Relationships button in the Database toolbar, or choose the Relationships menu item from the Tools menu.

In the Show Tables dialog window, select at least two tables to relate (or more, if desired) and click the Add button.  To close the dialog box, click the Close button.

To relate the tables, drag a field from one table to its related field in another table.  Complete the Edit Relationships dialog box and click the Create button to create the relationship between the two tables.

Notes:
None.

Section 5.1.2 – Working with Related Tables

Concept:
Enforcing the referential integrity of related tables

Method:
To enforce referential integrity between tables, click the Relationships button on the Database toolbar.  Right-click the relationship you wish to modify and choose the Edit Relationship menu item from the menu.

In the Edit Relationships dialog window, select the Enforce Referential Integrity check box.  Optionally, you can also choose to cascade update or cascade delete the related records.  Click the OK button when you have completed the edits to the relationship.

Notes:
None.

Section 5.1.3 – Printing the Relationships Window

Concept:
Printing the relationships window

Method:
To print the contents of the relationships window, click the Relationships button on the Database toolbar.  Choose the Print Relationships menu item from the File menu.  The Print Preview dialog window will open, showing a preview of the material to be printed.  Click the Print button on the Print Preview toolbar (likely the only toolbar showing) to send the material to the printer.

Notes:
None.

Section 5.1.4 – Setting Object and Database Properties

Concept:
Setting database properties

Method:
To set the properties of a database, choose the Database Properties menu item from the File menu.  In the Database Properties dialog box, use the Summary and Custom tabs to provide additional information about the current database.  Click the OK button to accept the change to the properties.

Notes:
None.

Concept:
Setting object properties

Method:
Properties of database objects (tables, reports, forms) can be modified as well.  Right-click the desired object and choose the Properties menu item from the shortcut menu.  In the Properties dialog box provide additional information about the object (such as a description).  Click the OK button to accept the changes to the properties.

Notes:
None.

Section 5.2 – Customizing Fields

This section concentrates on customizing fields including the creation of hyperlink fields in tables.  Topics covered are identifying and viewing object dependencies, modifying field properties, specifying a field’s display format, propagating property changes to forms and reports, defining a hyperlink field and changing a field’s data type.

Section 5.2.1 – Identifying and Viewing Object Dependencies

Concept:
View dependencies of database objects

Method:
Right-click the desired object in the database window and choose Object Dependencies from the shortcut menu, enable name AutoCorrect, if necessary, and view the dependencies in the Object Dependencies Pane.
At the top of the Object Dependencies pane, there are two display options—Objects that depend on me and Objects that I depend on.
Notes:
Before performing changes to field properties or a table’s structure, display the table’s dependencies and ensure that other database objects will not be adversely affected by the changes.
Section 5.2.2 – Modifying Field Properties

Concept:
Modifying the properties of a field in a table

Method:
To modify a field’s property settings, display the desired table in Design View.  Select the desired field in the Field Grid pane, the field’s properties should be displayed under the General tab of the Field Properties pane.  If the General tab is not selected, click on the tab.

Modify the properties as desired and click the Design View’s close window button to close the window.

Notes:
The number and availability of properties is determined by the field’s data type
Section 5.2.3 – Specifying a Field’s Display Format

Concept:
Specifying the display format property for a field

Method:
The Format property for a table field is used to specify how the field’s data is displayed and printed.  To modify this property, display and select the field as specified in Section 5.2.2 above.  In the field’s Format property area, enter a predefined format from the drop-down list or enter a custom format.

Notes:
Not every data type provides format items to select in the drop-down list.  The textbook covers three formatting characters (@, <, and >), though there are more.  Use Access’ Help feature to see the complete list of possibilities.

Section 5.2.4 – Propagating Property Changes to Forms and Reports

Concept:
Ensures consistency throughout the database
Method:
Propagate a field’s property change, such as the display format for a telephone number, so that the data appears with the same formatting on all forms or reports. 
Select the field property as shown in Section 5.2.2 above, click outside the property’s text box, click the Property Update Options button, select the objects that contain the bound controls you want updated, click yes.
Notes:
None.

Section 5.2.5– Defining a Hyperlink Field

Concept:
Inserting a hyperlink field

Method:
To insert a hyperlink field into a table, display the desired field in Design View.  Select an empty row in the Field Grid pane and type the field’s name in the Field Name column.  Select Hyperlink in the Data Type column to make the new field a Hyperlink type.  If desired, complete the Description column for this field.

Notes:
Use hyperlinks to move among your Office documents—click a link to display, for example, a worksheet in Excel 2003 or to open a Word 2003 document to a specific page.
Concept:
Entering a URL into a hyperlink field

Method:
To enter a URL as data into a hyperlink field, display the table in Datasheet View and select the record to edit.  Position the insertion point within the hyperlink’s cell (click the cell for the hyperlink field) and click the Insert Hyperlink button on the Database toolbar.

The Insert Hyperlink dialog box will appear.  Use the dialog to create a hyperlink to an Internet web site (by typing in the Address text area), or a document (by navigating to and double-clicking on the document’s icon).  Edit the text to display for the link in the Text to display text area and click the OK button to create the link. 

Notes:
None.

Concept:
Removing a hyperlink

Method:
Right-click on the desired hyperlink and choose the Remove Hyperlink menu item from the shortcut menu.

Notes:
None.

Concept:
Editing a hyperlink’s display text

Method:
To edit a hyperlink’s display text, right-click on the desired hyperlink and choose the Display Text menu item from the shortcut menu.  The menu item’s text area will be highlighted with the current link display text, which you can edit.  When you have completed your changes, press the Enter key.

Notes:
None.

Concept:
Editing a hyperlink’s address

Method:
To edit a hyperlink’s address, right-click on the hyperlink and choose the Edit Hyperlink menu item from the shortcut menu.  Use the Edit Hyperlink dialog box, as you did to create the hyperlink, to change its link address or display text.  Click the OK button on the dialog to complete the edits.

Notes:
None.

Section 5.2.6 – Changing a Field’s Data Type

Concept:
Changing an existing field’s data type

Method:
To change a field’s data type, open the desired table in Design View and select the row selector for the desired field.  Use the Data Type column’s drop-down menu to select a new data type for the field.  Click the Save button on the Database toolbar to save your changes.

Notes:
Access may not be able to convert the existing data into the new format. Always make a backup copy of the table before converting field data types.
Section 5.3 – Maintaining Your Data’s Integrity

Section 5.3 instructs students on a variety of features and procedures related to maintaining the field-level integrity of data.  The section covers the use of the Required, Default Value, Validation Rule, and Validation Text field properties.  Additionally, the section details the use of an Input Mask and the defining of lookup fields and lookup columns.

Section 5.3.1 – Enforcing Required Fields

Concept:
Enforcing that a field must contain data

Method:
To enforce that a field must contain data for each record, display the table’s structure in Design View, and select the appropriate field in the Field Grid pane.  Select the Required property in the Field Properties pane and select the Yes item from the drop-down list.

Notes:
Selecting the Yes value in the Required property for a field requires that a data value be present in this field for each record in the table.

Section 5.3.2 – Specifying Default Values

Concept:
Specifying a default value for a field

Method:
To specify a field’s default value, display the desired table’s structure in Design View and select the appropriate field in the Field Grid pane.  Select the Default Value property for the desired field and type the desired value in the property’s text area. 

Notes:
The value entered in the text area will automatically be entered into the field whenever a new record is created. A field’s default value may be modified or overridden at any time.
Section 5.3.3 – Validating Fields and Records

Concept:
Enforcing field-level validation

Method:
To enforce field-level data validation, display the desired table’s structure in Design View, and select the appropriate field in the Field Grid pane.  Select the Validation Rule property and type a validation expression into the property’s text area.  Additionally, enter a Validation Text message in the Validation Text property’s text area.

Notes:
For entering complex validation criteria, click the Build button  beside the Validation Rule property text box to display the Expression Builder.
Concept:
Enforcing record-level validation

Method:
To enforce record-level data validation, display the desired table’s structure in Design View, and choose the Properties menu item from the View menu.  In the Properties dialog box enter a validation rule in the Validation Rule property and validation text in the Validation Text property.

Notes:
None.
Section 5.3.4 – Using an Input Mask

Concept:
Entering an input mask for a field by using the Input Mask Wizard

Method:
To enforce how data is entered for a field, create an input mask for the field by using the Input Mask Wizard.  Display the desired table’s structure in Design View and select the appropriate field in the Field Grid pane.  Select the Input Mask property in the Field Properties pane and click on the property’s Build button to launch the Input Mask Wizard.

Next, use the wizard to select an existing mask or click the Edit List button to edit an existing mask.  Click the Close button to complete the wizard and the Finish button to close the Input Mask Wizard dialog window.

Notes:
None.

Section 5.3.5 – Defining a Lookup Field

Concept:
Defining the contents of a lookup field 

Method:
A lookup field can be used to provide a list of acceptable data values for a field.  To create the field and the list, display the desired table’s structure in Design View, and select the Lookup Wizard item from the Data Type drop-down list of the desired field.

Use the Lookup Wizard to build a new list from scratch or to build one as the result of a query to a table.  Upon completion of the wizard, click the Finish button to set the associated lookup field.

Notes:
None.

Section 5.3.6 – Inserting a Lookup Column

Concept:
Inserting a lookup column

Method:
A lookup column uses the same concept as a lookup field, the only difference being that the lookup values are created while you are viewing the data in Datasheet View rather than Design View.

To create the lookup column, display the desired table in Datasheet View.  Right-click on a field column and choose the Lookup Column menu item from the shortcut menu.  Use the Lookup Wizard (as described above) to finish creating the lookup values associated with this column.

Notes:
None.

Section 5.4 – Importing and Exporting Data

Section 5.4 covers the essentials relating to the importing and exporting of data into and from Access.  The section details importing database objects from another Access database, importing object structure and data from a structured file (spreadsheet, text or XML file), exporting a database object’s structure and data to one of a number of formats (another Access file, XML, HTML, RTF, etc.), and backing up your data.
Section 5.4.1 – Importing Access Data into a New Table

Concept:
Importing data from another database

Method:
To import database objects from one database to another, open the database in Access to which you wish to import the objects (destination).  Choose the Get External Data menu item from the File menu, and choose the Import menu item from the sub-menu.
Use the Import dialog box to navigate to the location of the database which contains the objects you wish to import (source), and double-click on the database’s icon.  In the Import Objects dialog box, click the tabs to view the different objects that can be imported, and select the individual objects to import.

Click the OK button to complete the import process.

Notes:
You can import tables, queries, forms, reports, pages, macros, and modules. Use the Options button on the Import Objects dialog box to further refine what characteristics of the objects are imported.

Section 5.4.2 – Importing Structured Data

Concept:
Importing structured data (spreadsheet, text file, XML file)

Method:
To import a structured data file (spreadsheet, text file, XML file) into Access, open the database into which you wish to import the data.  Choose the Get External Data menu item from the File menu, and choose the Import menu item from the sub-menu.

Next, use the Import dialog box to navigate to the location of the database which contains the objects you wish to import (source).  Be sure to use the Files of type drop-down list box to select the file type of the file you wish to import.  Once you have located the file, double-click on the file’s icon to import it into Access.

The Import wizard will then begin and guide you through the process of importing the file you have chosen.  The wizard’s prompts will vary depending on the input file type.

Notes:
Most every application program can import and export data using the ASCII text file format. Think of this format as the lowest common denominator for sharing and exchanging data.
Section 5.4.3 – Exporting Structured Data

Concept:
Exporting data

Method:
To export a database object as a structured data format, open the desired database in Access and select the desired object from the Database window.  Choose the Export menu item from the File menu.  In the Export dialog window, navigate to the location to which you wish to save the exported data, provide a filename for the destination file in the File name text area, and select a file format in the Save as type drop-down list.  Click the Export button to complete the exporting process.

Notes:
It is important to note that exporting data provides only a static representation of the data stored in an Access database. In other words, the data is reliable and accurate only as of the time of export.
Section 5.4.4 – Backing Up Your Data

Concept:
Make a backup copy of the database

Method:
Ensure that the database appears open in the Database window and choose the Back Up Database menu item from the File menu.
Notes:
When backing up a database file the filename will appear appended with the current date.
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Microsoft Access 2003
Extra-Curricular Activities

	Chapter 5

	Extra Curricular Activities


Activity 1 Use the sample data file AC0500 and create a new database named MyCopy.  (You might find it easier to copy and rename the database first before working with it.)  Open the relationships window and create a relationship in the database between the Instructors and Courses tables.  When you are done, print the relationships window and submit it for grading.

Activity 2 Open the MyCopy database (from Activity 1) and edit the properties for the Instructors table and provide a description of the table.  Likewise, open the Instructors table and provide a description for each field of the table.  Use the database documenter to print a report of the Instructors table and submit it to your instructor for grading.

Activity 3  Use the Export feature of Access to export the Courses table (table structure and data) to an XML file named MyCopyCourses.  Copy the file to a floppy disk and submit it to your instructor for grading. 

Resource IV

Microsoft Access 2003
Answers to End-of-Chapter Review Questions

Chapter 5 
Answers to End-of-Chapter Questions

Short Answer

1. The relational database model limits redundancy and the duplication of data through normalization. Smaller related tables are joined to share and exchange data. A flat-file database does not normalize its data. Therefore, all of the required data (duplicates included) is stored in a single table or disk file.

2. In a one-to-many design, a single record in table A can be related to multiple records in table B, but a single record in table B is related to only one record in table A. Whereas in a many-to-many relationship, a single record in table B is also related to multiple records in table A. Unlike a one-to-many design, a many-to-many relationship typically makes use of a third linking table to establish the physical and logical relationship.

3. Access assumes that you want to create a one-to-one relationship.

4. If a unique key field does not already exist, create an “ID” field using the AutoNumber data type.

5. In the Edit Relationships dialog box, select the Enforce Referential Integrity check box. Select the Cascade Delete Related Records check box. 

6. Format, Field Size, Decimal, and/or, Input Mask.
7. Default Value, Input Mask, and/or Lookup Field
8. Validation Rule, Lookup Field, and/or Input Mask
9. Instead of clicking in the field, right-click its contents and choose the Hyperlink command. In the cascading menu, choose to remove the hyperlink, edit the display text, or modify the hyperlink using the dialog box.

10. Export the table object to an HTML document or to an XML data file using the File, Export command. Upload the document(s) to a Web server.

True/False

	1.
	T
	6.
	T

	2.
	T
	7.
	T

	3.
	T
	8.
	F

	4.
	T
	9.
	F

	5.
	F
	10.
	F


Multiple-Choice

	1.
	a
	6.
	c

	2.
	c
	7.
	d

	3.
	d
	8.
	b

	4.
	a
	9.
	c

	5.
	b
	10.
	b
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